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1. General Information 

1.1. Overview of the SATGEN Satellite Data Generation Program 

SATGEN is a graphical user interface (GUI)-based program used to generate data 
files necessary for the Dynamic Mode of dBm’s Satellite Link Emulator. The 
program calculates Doppler, delay, path loss and fading data for a specified 
satellite orbit and Earth transponder position. 

1.2. Features and Functions 

This program allows you to simulate a communication path between an orbiting 
satellite and up to four ground stations. Any orbit or ground position can be 
entered. Pre-set parameters include: 

• nine predefined satellite orbits, and 

• ground station coordinates for over forty cities world-wide 

You can monitor the progress of the satellite orbit through simulated view of a: 

• three dimensional view of the satellite orbiting the Earth, 

• ground trace of the satellite orbit over a flat map of the Earth, or 

• look angle with respect to the ground station. 

Additionally, the generated data is available in both graphical and tabular form. 
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2. System Requirements and Installation 

2.1. System Requirements 

This program runs directly on any Windows compatible computer with 4MB of 
RAM, a VGA monitor, and optional mouse. 

 

2.2. Password 

To save the data for use with dBm’s SLE Satellite Link Emulator, you must enter 
a password supplied by dBm. You may enter the password from the Help menu, 
or you will be prompted for the password when you attempt to save the file. The 
password validation is required only once. 
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3.  Overview 

3.1. Window Components 

The SATGEN program graphical user interface is provided through four main 
areas: Title Bar, Menu Bar, Run Bar,  and View Bar (see Figure 3-1). 

 

 

 

Figure 3-1. Four Main Areas of the Display Window 

 

3.2. Using the Mouse and Keyboard 

You may use the mouse, keyboard, or a combination of the two to operate any of 
the SATGEN controls on any of the display screens 

Title Bar 
Menu Bar 

Run Bar 
View Bar 
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3.2.1. Operating SATGEN with the Mouse 

Click the left mouse button once to activate any of the buttons or scroll bars.  

Modify scroll bars by using any of the following techniques (see Figure 3-1): 

  

  

 

 

  
 

Figure  3-2. Scroll Bar Use 

 
 

3.2.2. Operating SATGEN from the Keyboard  

You many use the mouse, keyboard, or a combination of the two to operate any of 
the SATGEN controls. 

Menu Items 

To access the menu commands, hold down the Alt key and press one of the 
following letters: 

 F File Menu 

 O Options Menu 

 H Help Menu 

When the drop-down menu appears, use the Arrow keys to scroll through the list. 
Select a command by pressing Enter, or leave the menu by pressing Esc. 

Controls 

All control groups can be accessed by Tabbing to the control or group of controls. 
There are six types of SATGEN controls: 

Radio Buttons - used to select one and only one option from a group. Tab 
to the group, then use the Arrow keys to change which option is selected. 
The View Type buttons are examples of radio buttons. 

Push Buttons - used to initiate some type of action. Tab to the button, 
then press the Space bar to push. The Reset, Preview, and Pause buttons 
are examples of push buttons. 

Dragging the 
marker with the 
mouse. 

Clicking the area 
adjacent to the marker 
for coarse adjustments. 

Clicking the 
arrows at the end 
points for fine 
adjustments. 
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Combo Boxes - used to select one and only one option from a group. Tab 
to the box, then use the Arrow keys to cursor through the list. The Map 
Type box in the Satellite view is an example of a combo box. 

Edit Boxes - used to enter numerical or character data. Tab to the box, 
then type in the data required. Press the Enter key to validate the data. The 
Number of Samples box in the System Setup dialog is an example of an 
edit box. 

Scroll Bars - used to increment a setting by a preset amount. Tab to the 
bar, then press the Arrow keys to increment or decrement the setting. The 
3-D display is an example of a window with scroll bars. 

List Boxes - used to select one item from a list of items. Tab to the list, 
then use the Arrow keys to cursor through the list. The Location List in 
the Earth Station dialog box is an example of a list box. 
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4. Operation 

4.1. Getting Started 

You can create the data files for use with the SLE700 by the following steps. 

1. Setup the desired satellite orbit, earth stations, and path loss models. 

2. Preview the file to verify that the settings achieve the desired orbit. 

3. Generate the data and view as graph or table. 

4. Save the file. 

 

4.2. Initializing SATGEN 

 

4.2.1. Select the Number of Links 

At the onset of starting the SATGEN program, the number of links must be 
selected. A link is defined as a connection between an Earth station and the 
satellite. Data files will be generated for each link. Up to four links can be 
enabled, representing four Earth stations. The Earth station locations can be 
unique, or they can be identical. Identical Earth station locations would be used to 
simulate a round trip channel (Earth station to satellite, and back to the Earth 
station). 

 

4.2.2. Select the Link Configuration 

The Link Configuration under the Options menu is used to configure how link 
data will be stored. Default conditions (Link1=link1, Link2=link2, etc.) cause the 
data files to represent the connection between the satellite and the Earth station 
defined for that link. Link data can also be combined to simulate a complete 
forward or reverse channel. For example, a unique Earth station location can be 
assigned for Link1 and for Link2. Link1 data can be configured to be the sum of 
the Link1 and Link2 (select the option for Link1=link1 + link2). When the data 
files are saved, the Link1 data will represent the parameters for the complete 
channel from Earth station 1 to the satellite and back to Earth station 2. 
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4.3. Loading Files 

4.3.1. Opening  Existing Configuration Files 

Opening a file causes the system setup and data files that are stored in files to be 
loaded into the SATGEN application’s program. The file name will appear in the 
Title Bar. Since fading and path loss are combined when data is saved, the atn.dat 
file will be loaded into fading, and no data will be loaded into pathloss. 

4.3.2. New Files 

Selecting a new file causes SATGEN to initialize to preset conditions. The file 
name will appear as "Untitled" in the Title Bar. 

4.4. Saving Files 

SATGEN saves the system setup and link data in separate files. The system setup 
is stored with the file extension .gen. The link data file names are specified in the 
Earth Station dialog box. The file format for the link data is compatible with 
dBm’s SleControl program and dll, which interface with the SLE700 Satellite 
Link Emulator. 

4.4.1. Saving a File Under a New File Name 

To save a file under a new name, select File, Save As from the menu bar; enter the 
new name and click on Save. 

4.4.2. Overwriting an Existing File (Save) 

Using the File, Save command will store the file on the hard drive under the name 
that appears in the Title Bar. SATGEN automatically appends an extension of 
.gen to files. 
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4.5. Editing Files 

Before you run a file, you need to set up the system parameters. Press the Setup 
button on the Run Bar to invoke the System Setup dialog box (see Figure 4-1). 

 

 

 

 

 

 

 

 

 

 

 

Figure  4-1. System Setup Dialog Box 

 

 

Number of Samples 
Enter the number of 
data samples you want 
calculated for 
SLE.EXE data files. 

Satellite Setup 
Press to invoke 
Satellite Setup 
dialog box. 

Earth Station Setup 
Press to invoke Earth 
Station dialog box. 

Path Loss Model 
Press to invoke Path Loss Model 
dialog box. 

Time Increment 
Enter the time between 
samples in seconds. 

Maximum Fading 
Enter the maximum 
fading in dB. 

Frequency Offset 
Enter a fixed frequency 
offset in kHz. Applied to 
all links. 
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4.5.1. Satellite Setup 

Click the Satellite button on the System Setup dialog box to invoke the dialog box 
for setting the satellite type and orbit (see Figure 4-2). See the Glossary of Terms 
section for a detailed description of the orbital parameters. 

 

 

 

 

 

 

 

 

 

 

 

Figure  4-2. Satellite Setup Dialog Box

Satellite List 
Select the satellite you 
want to use in the run 
from the list of 
available satellites. 

Description 
Edit the 
description  Type 

Select from 
geostationary, 
geosynchronous, 
circular or other. 

Longitude 
Edit the right 
ascension angle. 
For geostationary 
satellites, this 
will represent the 
position over the 
Earth. 

Inclination 
Edit the angle between 
the orbital and equatorial 
plane. 

Initial Mean Anomaly 
Edit the starting angle 
of the satellite. 

Perigee 
Edit the perigee 
in km. 

Eccentricity 
Edit the 
eccentricity of 
the satellite 
orbit. 

Argument of Perigee 
Edit the argument of 
perigee. 

Delete 
Delete the currently 
selected satellite 
from the list. 

New 
Add a new 
satellite to 
the satellite 
list. 
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4.5.2. Earth Station Setup 

Press the Earth Station button on the System Setup dialog box to invoke the 
dialog box for setting the ground stations and data file names (see Figure 4-3). 

 

 

 

 

 

 

 

 

Figure  4-3. Earth Station Setup Dialog Box 

Locations 
Select from the list 
of preset locations. 

Copy Location 
Press to copy settings for 
selected location. 

Description 
Edit the 
description of the 
Earth Station 
transponder. 

Latitude and 
Longitude 
Select the 
latitude and 
longitude for 
the Earth 
Station. 

Data File 
Names 
Edit the file 
names for 
the link data. 

Link List 
Select the number 
of the link to view 
and edit. 

Center 
Frequency 
Used to 
calculate 
Doppler. 
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4.5.3. Path Loss Model Setup 

Press the Path Loss Model button on the System Setup dialog box to invoke the 
dialog box for setting the atmospheric heights and losses (see Figure 4-4). 

 

 

 

 

 

 

 

 

 

 

 

Figure  4-4. Path Loss Model Setup Dialog Box 

Number of Layers 
Select the number of 
atmospheric layers. 

Path Loss 
Enter the path loss for 
the atmospheric layer 
in db/km. 

Altitude 
Edit the altitude or drag 
layer numbers with mouse 
while holding down the 
left mouse button. 

Change Maximum Altitude 
Press to invoke a dialog box for entering 
the maximum altitude  represented by 
the model. 
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4.6. Previewing a Simulation 

4.6.1. Previewing a File 

Once all parameters have been set to their desired values, you can preview a 
simulation by pressing the Preview button, which appears on the Run Bar (see 
Figure 4-5). The Status display will change from READY to RUNNING and the 
timers will increment as the simulation runs. Previewing the simulation shows the 
orbit path and satellite parameters. Previewing the file does not generate data for 
the Table view or Graph view, and data will not be saved for use with SLE700. 

 

Figure  4-5. Run Bar 

 

4.6.2. Pausing a File 

You can pause a file during a preview run by pressing the Pause button, which 
appears on the Run Bar. The Status display will change from RUNNING to 

View Type 
Select Satellite to preview. Select Graph or Table to view 
the data.  

Reset, Preview, Pause 
Control the preview through these buttons. 

Preview Displays 
The preview status, elapsed time and mean anomaly are 
displayed. 

Setup 
Press to invoke the System Setup dialog box. 

Generate Data 
Press to calculate the Doppler, delay, path loss and 
fading for each sample. 
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PAUSED and the timers will stop incrementing. Click the Preview button to 
resume the run. 

4.6.3. Resetting a File 

You can reset the file to its initial conditions by pressing the Reset button. 

4.6.4. Data Generation  

After you have the desired satellite orbit settings, press the Generate Data button 
to calculate the Doppler, delay, path loss and fading for each data sample. This 
data will appear in the Table view and Graph view, and can be saved for use with 
SLE700. 

4.6.5. Data Triggering 

Data triggering is selectable via the Options menu. Using the default condition of  
All Data, data is generated on all links for the total number of sample points. 

To trigger data generation based on a line of sight link, select Line of Sight 
Trigger from the Options menu. If checked, the program begins to generate data 
when the satellite is in the line of sight of the Earth station and stops generating 
data when the satellite goes out of the line of sight. The sample number and initial 
mean anomaly of the setup are changed to match this duration.  

Selecting Single Line of Sight causes all links to start and stop simultaneously 
based on an existing line of sight for link 1. Selecting Multiple Line of Sight 
causes data generation to begin when any of the links have an existing line of 
sight. Once data generation has started, it will continue until the total number of 
samples has been created. 

 

4.7. Viewing Data 

You can change the view on the View Bar by selecting the View Type on the Run 
Bar. You can view the data for different  transponder links by selecting the Link  
combo box on the View Bar. The Link combo box is only available for the 4 
transponder link version of this program.
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4.7.1. Graph View 

This view displays the data  that was generated by pressing the Generate Data 
button in a graphical format (see Figure 4-6). Use the scroll bar to scroll the data 
in the window. To see the data values at any point in time, drag the vertical cursor 
across the graph to the desired location. 

 

 

 

 

 

 

 

 

Figure  4-6. Graph View

Vertical Cursor 
Drag the cursor across 
the graph.  

Data Values 
The data values corresponding 
to the current cursor position 
are displayed. 

Scroll Bar 
Use the scroll bar to 
move across the graph. 
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4.7.2. Table View 

This view displays the data that was generated by pressing the Generate Data 
button in a table format (see Figure 4-7). Use the scroll bar to scroll the data in 
the window. 

 

 

 

Figure  4-7. Table View 

Scroll Bar 
Use the scroll 
bar to move 
down the table. 



  

 19 

 

4.7.3. Satellite View 

The top of this view displays the link configuration, Earth station position, and 
satellite position (see Figure 4-8).  

 

 

 

 

 

 

 

Figure  4-8. Top of Satellite View Bar 

 

The bottom of this view can display one of three perspectives: 

3-D - shows the Earth and satellite in motion.  

 

Figure 4-9. 3-D Display of Satellite Bar 

Link Configuration 
Displays the selections made in 
the Link Configuration option. 

Earth Station and Satellite Positions 
Display in coordinance form and look 
angles. 

Map Type 
Select map type 
for satellite 
perspective. 

Trace 
Select Trace to draw 
path of satellite. 

Zoom 
Zoom in or out 
of current 
display. Not 
valid for ground 
trace view. 

Link 
Select the link 
data  you want to 
display. 
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Ground Trace - shows the satellite and Earth transponder position 
displayed on a rectangular map of the Earth according to longitude and 
latitude. 

 

Figure  4-10. Ground Trace Display of Satellite Bar 

 

Horizon - shows the satellite position from the Earth transponder 
perspective according to azimuth and elevation. 

 

Figure  4-11. Horizon Display of Satellite Bar 

 

Use the scroll bar on any of these displays to step through the run. 
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Parameter Data File Descriptions 
 
All parameter file names are limited to 10 characters. The first 4 (or 5) characters are 
predetermined as defined below. Up to 5 (or 6) characters can be added to the name. For 
example, DLY1.dat can be modified to DLY1abcdef.dat. DLY12.dat can be modified to 
DLY12abcde.dat. 
 
The data in the stored files is dependent on the selected Link configuration. 
The default link configuration is for the stored files to be equal to the values calculated 
for that link. Example: Link1 data = Link1. The data files would be called DLY1.dat, 
FRQ1.dat, etc. 
If two links are combined, the values from those two links are added and the data file is 
created from the sum.  
Example #1: Link1 data = Link1+Link2. The computed values for link1 and link2 are 
summed and the resultant file would be called DLY12.dat, FRQ12.dat, etc.  
Example # 2. Link 3 data = Link1+Link3. The computed values for link1 and link3 are 
summed and the resultant file would be called DLY31.dat, FRQ31.dat, etc. Note that the 
"3" comes first in the file name because this becomes the Link3 data. 
 
File Format 
Parameter data files must be generated in ASCII format. The first line in the file is a value 
that represents the number of sample points in the file. Each subsequent line will contain 
one data value. Lines are separated by a carriage return. An example of a delay file with 3 
points is: 
 
3 
12.456789 
12.456788 
12.456787 
 
 
 
The ASCII parameter files must have a file extension of ".dat" in order to be recognized 
by the SleControl program and SLE700 dll. The SATGEN satellite data generation 
program automatically generates the correct file extension. User generated files should be 
created with the .dat extension also. The first three letters of the file name must be one of 
DLY, FRQ, ATN, or PHA to represent delay, frequency offset, attenuation, or phase 
offset files. Up to 7 alphanumeric characters can follow the first three letters in the file 
name. 
 
Delay File Data Format 
 

§ Each data point consists of ten characters including a decimal point 
§ Range is 0.1ms to 697ms in 1ns increments 
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§ Valid change (Delta) between any two adjacent points must not be greater then 
20us 

§ Units are ms 
  
Attenuation File Data Format 
The attenuation file generated by SATGEN represents the sum of the link fading plus the 
link path loss. Although SATGEN displays fading and pathloss separately, they are 
combined into the atn.dat file when saved. 

§ Each data point consists of five characters including a decimal point 
§ Range is 0 to 40 dB in 0.25dB steps 
§ Step size between any two adjacent points can be up to 40 dB 
§ Units are dB 

 
Frequency Offset Data Format 
The frequency offset file generated by SATGEN represents the sum of the link Doppler 
plus the fixed Frequency Offset. Note that the Frequency Offset value is applied to all 
links. This value defaults to zero. SATGEN displays the sum of  Doppler fading and the 
Frequency Offset,  and the sum is saved in the frq.dat file. 
 

§ Each data point consists of eight characters including a decimal point 
§ Range is 0 to ± 3000 kHz 
§ Step size between any two adjacent points can be up to ± 3000 kHz 
§ Units are kHz 

 
Data File Sizes 
Parameter data files can contain up to 1.8 million data points. 
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5. Glossary of Terms 

Argument of Perigee:   The angle in the orbital plane between the line of nodes 
and the perigee of the orbit. Shown as ωω in Figure 5-2.  

 

Azimuth:   The angle between true north and the direction of the 
satellite measured in the clockwise direction. 

 

Eccentricity:   The ellipticity of the orbit, calculated as  

e
b

a
= −







1

2

 

 where a is the semi-major axis and b is the semi-minor axis 
of the elliptical orbit (see Figure 5-1). 

 

Elevation:   The angle from the horizon to the satellite. 

 

Inclination:   The angle between the orbital plane and the equatorial 
plane.  Shown as i in Figure 5-2. 

 

Initial Mean Anomaly:  The initial angle from the perigee of the satellite. 

 

Mean Anomaly:   The angle from the perigee that the satellite would traverse 
in at any given time. Shown as θθ in Figure 5-1. 

 

Right Ascension:   The angle between the X-axis and the ascending node. 
Shown as ωω in Figure 5-2. 

 

Perigee:   The point of orbit closest to the Earth. 
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Figure  

Figure  5-1. Parameters in an Elliptical Orbit. 
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Figure  5-2. Orbital parameters 


